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1. Welcome to The Grid 2 
The Grid 2 allows people with physical and sensory 
disabilities to communicate. 

ACCESS FOR EVERYONE 

The Grid 2 has been designed to be universally 
accessible.  It can be used by people with a wide range 
of physical difficulties who can take control with a 
mouse, touchscreen, head pointer, switches or other 
access methods. 

VOICE OUTPUT COMMUNICATION… 

The Grid 2 is used to create powerful communication 
systems for people with no speech or limited speech.  
There is full support for symbols users and The Grid 2 
comes with high quality voices for voice output 
communication. 

…AND MORE 

The Grid 2 is a complete environment for using a 

computer.  The software includes word processor, email, 
web browser and other tools within the grids providing 
broad functionality in a controlled environment.  The 
Grid 2 also provides computer control for access to 
other Windows applications. 
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1.1. Communicating with The Grid 2 
One of the main uses of The Grid 2 is as a Voice Output 
Communication Aid (VOCA), and high quality voices are 

included in the package. 

The Grid 2 provides 4 different options for constructing 
communication sentences: 

INSTANT SPEECH 

As soon as a cell is selected, the associated text is 
spoken. 

SIMPLE SYMBOL CHAT 

Each word or phrase selected appears as a symbol in the 
sentence bar.  

This is the same as the symbol output that is available 
in The Grid version 1. 

SYMBOL CHAT 

Words appear in the sentence bar with symbols above 
them.  Words can be edited using the keyboard or other 
cells. 

TEXT CHAT 

Words appear as text in the sentence bar.  The text can 
be edited using the keyboard or other cells. 

 

These different ways of building sentences allow users 
to progress from instant messages through symbol 
sentence construction and on to writing with text.  More 
information about the different ways of writing 
sentences can be found in the chapter on Workspaces. 
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1.2. New ways to communicate 
In addition to voice output communication, The Grid 
makes new communication technology available to users 

of all ability levels. 

EMAIL  

You can send and receive emails using The Grid 2, as 
long as your computer is connected to the internet. 

Note that you will need an email account; this is not 

provided with The Grid 2, but instructions for setting 
up a free email address are available. 

SMS TEXT MESSAGES 

Sending and receiving SMS messages is possible if you 
have a mobile phone with Bluetooth connection. 

 

Messages for SMS and email can be written with or 
without symbol support.  The messages are sent and 
received as plain text (without symbols), and can be 
read aloud using The Grid’s speech output. 
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1.3. Beyond communication 
The Grid 2 does more than just communication!  You 
can browse the web, use the built-in calculator or listen 

to music stored on your computer.  There is also a word 
processor for writing and saving documents within The 
Grid 2. 

Additionally, The Grid 2’s computer control provides 
access to Windows programs without a keyboard and 
mouse. 

Computer control grids can be used in place of a 

physical keyboard and mouse.  They can include symbols 
and special cells for launching programs and accessing 

program functions directly.  You can also use 
communication grids to write into Windows programs. 
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2. Using The Grid 2 for the first time 

2.1. Installing The Grid 2 
Start the installation by putting the CD into your 

computer’s CD drive. 

If the installer does not automatically start after a few 

moments, go to My Computer and double-click on the 
CD drive. 

When the installer starts, follow the instructions to 

install The Grid 2 onto your computer. 

If you are installing onto a network, please see the 
separate guide for network installations. 

2.2. Installing your speech 
Insert the speech CD into your computer and the 
installer will auto play.  If you are unsure which voice 

you wish to use, install all the voices for your language. 
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2.3. Launching The Grid 2 
Once the installation is complete you are ready to start 
using The Grid 2! 

You can launch The Grid 2 from the Start Menu: 

Start > Programs > Sensory Software > The Grid 2 

The first time that you run The Grid 2, it launches Grid 
Explorer (you can change this later – see Program 
Preferences). 

If you haven’t used The Grid 2 before, you may want to 
read chapter 3 to get started. 
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2.4. Licensing The Grid 2 
The Grid 2 installs as time-limited software that you can 
use for evaluation.  If you have purchased the software, 

you will need to use your licences for The Grid 2 and for 
the speech. 
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3. Finding your way around 
This chapter will take you through the program to 
introduce the basics.  If you’ve used The Grid or similar 

software before, you might want to skim this as much of 
it will be familiar, but some of it is exciting and new. 

3.1. Users, grids, grid explorer – oh my! 
Before we get into too much detail, a quick summary of 
the terminology and concepts in The Grid 2 might be 
useful. 

• Grids are the screens that are seen most of the 

time when working in The Grid 2.  They consist of 
a number of buttons, called cells which will write 
into the sentence, speak or perform other actions.  
Grids usually have a sentence writing area called 
the workspace.  Grids are sometimes referred to 
as pages. 

• Users are the people who use The Grid 2.  The 
Grid 2 has been designed to allow more than one 
person to share a computer.  As the needs of 
each person may be quite different, each user 
has their own set of grids and unique settings for 
access and speech. 

• Grid Explorer provides a user-friendly way to see 
your users and their grids, and make changes such 
as copying or renaming grids. 

• The Grid Player is used to view and edit grids. 

3.2. Grid Explorer 
Grid Explorer allows you to view users, and edit and 

share their grids easily.  When you start The Grid 2 you 
will be taken to Grid Explorer. 

If The Grid 2 starts with a screen that is very different 

from the one below, you have probably changed your 
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program settings so that it starts in the Grid Player.  
It’s no problem to open Grid Explorer: 

1) If you can’t see a menu bar at the top of the 

grid, press F12 to display it. 

2) Select File > Grid Explorer from the menu. 

3) Click on the View users icon in the toolbar. 

 

 

 

The Grid Explorer window is divided in to 2 main regions.  
On the right, filling most of the window is the list of 

grids or users that you are viewing.  To the left is a 
context-sensitive list of options; as you select different 
users and grids, the options presented in the explorer 
bar will change to reflect the most useful actions. 

There is also a toolbar and a menu bar at the top of the 
Grid Explorer window for accessing other functions. 

EXPLORING USERS 

When you start The Grid it displays a list of users.  Click 
on one of the users and you will see that the options on 
the left change to show the common tasks that can be 
performed – things like renaming the user or creating a 
backup of the user’s files to a CD. 
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EXPLORING GRIDS 

You can also use Grid Explorer to see a list of grids for 
one of the users on your computer.  Click on one of the 
users to highlight it, and then select Explore User. 

When you are viewing grids, you can create new grids, 

copy grids and share grids.  You can display the list with 
a thumbnail of each grid (to make it easy to identify 
grids) or as a chart showing how the grids link together.  
To change the view in Grid Explorer, select the View  
button on the toolbar. 

 

ACTIVATING A USER 

If you are not viewing a list of users, click on the View  

users button on the toolbar. 
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We’re going to move on to look at other parts of The 
Grid 2 now, but if you want to know more about Grid 
Explorer, you can refer to chapter 15. 

You can now activate one of the users by double-

clicking on the user, or selecting Activate User from the 
bar on the left. 

3.3. Grid Player 
When you activate a user, it launches the Grid Player.  
This is the interactive environment that allows users to 
communicate, listen to music, go on the Internet and all 

the other brilliant things that The Grid 2 offers. 

The appearance of the Grid Player can vary widely, 
according to the user settings and the user’s grids.  
Some users will have grids with just a few large cells for 
simple communication choices; others will have more 
complicated grids with many cells for flexible and fast 
responses in conversation; and others might have an on-

screen keyboard that occupies a corner of the screen for 
interacting with Window applications. 

Most grids have a workspace, a largish rectangular area 
for constructing sentences and other activities.  The 
workspace is very flexible – it can be used for writing 
symbol sentences, sending emails, browsing web pages 

and more. 

3.4. Editing grids 
In addition to interacting with grids, Grid Player is used 
for editing grids.  To make changes to a grid you can 
press F11 to enter Edit Mode.  When editing, there are 
a few extra areas on the screen layout: 

• The bar on the left provides access to common 
tasks. 

• The tool bar allows you to perform actions such 
as saving changes, or opening a different grid. 
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• The main part of the screen (the grid area) allows 
you to move, resize and edit cells. 
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4. Introduction to Workspaces 
Most grids have a large box at the top for writing into.  
As you will soon discover, this box, called the workspace, 

is very flexible and can be used to write emails, do 
calculator sums, play music and many more things.  It 
can also change size, so it might be a strip along the top 
of one grid, but occupy most of another grid. 

 

There are quite a few workspaces (and we hope to add 
more in the future), so it helps to consider them in 
groups with similar functionality. 

VOICE OUTPUT COMMUNICATION WORKSPACES 

These workspaces are primarily intended for 
communication.  The user constructs sentences in the 
workspace, and the sentence is then spoken aloud. 

• Text chat 

• Text chat + messages 

• Symbol chat 

• Simple symbol chat 
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MESSAGING WORKSPACES 

These workspaces allow remote communication using 
different ways to send messages. 

• Email 

• SMS 

• Contacts 

OTHER WORKSPACES  

The remaining workspaces are not for communication, 
but provide other valuable features for users of The Grid 

2. 

• Word processor 

• Web browser 

• Calculator 

• Music player 

• My settings 

• Clock 

• Computer control 

Here is a more detailed look at these workspaces, with a 
summary of what each is used for. 

4.1. Text chat workspace 
The text chat workspace provides a place for the user to 
write sentences for speaking.  Text can be entered via 
grids with single letters, words, phrases or even 
complete sentences.  A keyboard can also be used to 
type into the text chat workspace. 

4.2. Text chat + messages workspace 
The text chat + messages workspace is very similar to 
the text chat workspace, but the user can store 
messages and easily recall messages that were stored 
previously.  Users can also maintain several lists of 
messages. 
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4.3. Symbol chat workspace 
Symbol users can construct sentences with symbols and 
text, providing support for literacy. 

The symbol chat workspace can also allow users to save 
their sentences, either to speak later or as evidence of 
work. 

4.4. Simple symbol chat workspace 
This provides a really basic way to start building 
sentences.  Sentences are constructed block-by-block 
and the user can understand how the selections 

correspond to the changes in the sentence bar. 

4.5. Email 
Your inbox provides the starting point in the email 
workspace.  From here you can read emails that have 
been sent to you, and reply to them or delete them.  
You can also start a new email.  An internet connection 

is required to send or receive email. 

4.6. SMS 
The SMS workspace allows you to send SMS messages via 
a compatible mobile phone. 

SMS messaging is often called text messaging or texting.  

We have referred to it as SMS messaging to avoid 
confusion between the SMS workspace and the text chat 
workspace. 

You can read SMS messages that have been sent to you, 
or send new messages to friends.  

4.7. Contacts 
The contacts workspace is used with the SMS and email 
workspaces to select who the messages are sent to. 
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4.8. Word processor 
The word processor workspace allows users to write 
documents and change formatting such as font style, 

bold, italic and text alignment.  Users can then save 
their documents and edit documents that were written 
earlier. 

4.9. Web browser 
Computers with an internet connection can browse web 
pages via the web browser workspace.  You can exclude 
certain websites, or limit the user to a ‘white list’ of 

sites if you like. You can also override any font size and 
colour settings to make pages more accessible. 

4.10. Calculator 
The calculator workspace allows the user to perform 
simple arithmetic. 

4.11. Music player 
The music workspace provides easy access to your entire 
music collection.  Music is stored and organised using 
Windows Media Player, and The Grid 2 automatically 
discovers what music you have and allows users to play 
tracks with ease. 

4.12.  My settings 
This workspace allows users to see the battery life and 
volume level on their communication aid. 

4.13. Clock 
The clock workspace displays the current time.  You can 
have an analogue or digital display, with the option to 
display the date and other settings too. 

4.14. Computer control 
Computer control is a special workspace, and it works 
slightly differently from the other workspaces.  When 
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the workspace is active, the grids are not displayed full-
screen; they occupy a small part of the screen to allow 
the remaining space to be used for other Windows 
programs.  The Grid 2 can be used to write into these 

other programs, as well as move the mouse pointer and 
interact with Windows in other ways. 

4.15. No workspace 
For really simple communication, you may wish to have 
a grid that does not have a workspace.  This is discussed 
later in this book. 
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5. Editing grids 
You will want to edit grids right from the start with The 
Grid 2, to customise them for a particular user or add 

additional features. 

5.1. Before you start 
Before you dive in and start editing, please consider 
what you are going to edit. 

You could create a new user, a blank slate, and start 
making cells and grids from there.  If you’re making a 
small number of grids this will be fine, but for a larger 

communication system you should consider adapting 
grids that are already available. 

We have a wide range of grids available for The Grid 2, 
including free grids provided with the software, 
extensive symbol vocabularies that have been authored 
by experienced speech therapists, and grids that other 

users have made and shared online.  Through these 
routes, you will often find that the grids you want have 
already been created.  It is definitely worth checking to 
see what is available before you set about creating a 
large number of grids. 

SENSORY SOFTWARE GRIDS  

The Grid 2 is provided with a number of users that are 

ready to go.  These provide communication systems for 
a variety of typical users, and it is worth looking at each 
of these in detail to see if they provide what you are 
looking for. 

GRID SETS / VOCABULARIES  

The grid sets available for The Grid 2 include Ingfield 

Dynamic Vocabularies, CALLtalk and WordPower.  
These carefully thought out, systematic sets of grids 
have been designed to provide effective communication 
for different user requirements. 
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ONLINE GRIDS  

The online grids service allows anybody to share grids.  
Other people may have created Grid 2 communication 
systems that meet your needs, or have ideas for grids 

that you can use. 

If you do have a new idea and you create grids that 
others might find useful, please consider sharing them 
online. 

The online grids website can be found at: 

http://grids.sensorysoftware.com 

You can read more about online grids in section 17. 

CUSTOMISATION 

If you choose to work with a grid set that has already 
been created, you will almost certainly want to start by 
editing these grids. 

You may wish to create a copy of the original grids so 
that you can reverse any changes you make.  The 
easiest way to do this is through Grid Explorer.  You 
could make a copy of the user, or consider burning it to 
a CD for safe-keeping. 

5.2. Commence editing 
Locate the grid that you wish to edit and start editing 
by pressing F11.  If you wish to experiment, it is a good 
idea to start on a grid with some blank cells. 

THE EDITING SCREEN LAYOUT 

The Grid Player window changes slightly when you are 
editing.  There is an extra bar to the left with options 
and a toolbar at the top of the screen.   
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We’ll discover what all these options do later, but first 
of all let’s try editing some cells. 

5.3. Creating a vocab cell 
Vocabulary cells are the meat of communication grids.  
You’ll be creating these pretty often if you are making 

grids for talking, so we’ve tried to make it as easy as 
possible.  Follow these steps to make a vocab cell: 

1. Choose a blank cell to edit. 

2. Left click on the cell using the mouse.  The cell 
will get a blue border with a cross through the 
middle to indicate that it is selected. 

3. On the left-hand side of the screen, click on the 
words Edit Cell that appears at the top of the list 
of cell options.  

4. Type the word that you want to be written in the 
cell. 
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5. Click Ok to accept the changes to the cell. 

Wow!  That was pretty easy, but there was actually 

quite a lot going on there.  Let’s run through it again 
more slowly to see what happened. 

1. Select another blank cell.  As you already have a 
cell selected, you could just use the arrow keys 
on the keyboard to move the selection around.  
This means that you don’t need to use the mouse 

– very handy for saving time. 

2. When you select a cell, the Cell Options on the 
left of the screen show the actions available for 
that cell.  The first option is Edit Cell, and to 
make things really quick this can be activated 
with the enter key. 

3. When you edit the cell the Edit Cell window 

appears.  This is split into 2 areas, cell 
appearance and commands, with a bar of 
common tasks on the left.  This window gives you 
complete control over what happens when the 
user selects the cell - we’ll look at it in more 
detail later, but for now we just want to type.  
The text cursor will already be blinking in the 

Vocab cell box on the left, so type in there.  As 
you type, you’ll see that the word(s) you write 
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appear in other places, and a picture is displayed 
automatically if one can be found.  You may also 
notice the cell change colour.  This all happens 
because The Grid 2 knows which settings are 

common for most vocab cells – leaving you to just 
type a word with the rest taken care of for you. 

4. You then click Ok (or press Enter) to accept the 
changes – but you may wish to check that the 
picture is ok first!  If you don’t like the picture 
that has been located, click on Change Picture 

and you can select a different one. 

5.4. Selecting cells 
You can select a cell using the mouse or the keyboard. 

To select cells using the mouse, simply click on the cell 
that you want to select.  You will see a blue border 
around the cell and a blue cross through the middle of 
the cell.  To deselect it, click on it again. 

You can use the arrow keys to move the selection 
around to different cells. 

 

SELECTING MORE THAN ONE CELL 

To select more than one cell, you can hold the Ctrl key 
whilst clicking on cells.  You can also drag the mouse 
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whilst holding the control key to select a number of 
cells. 

SELECTING THE WORKSPACE 

You will notice that the workspace is a cell that can be 

selected just like any other cell. 

5.5. Moving and resizing cells 
If you have one or more cells selected you can move 
them by dragging them with the left mouse button to 
the place where you want them to be. 

Note that when you drag a cell onto another cell, the 
cell that it covers up is deleted. 

When you have just one cell selected, you can resize it.  
Around the edges of the cell are white boxes.  Place the 
mouse pointer over one of these and drag it away from 

the centre of the cell to make the cell larger. 

5.6. Cell options 
When you select a cell in Edit Mode, the Cell Options 
(visible on the left of the screen) displays the most 
common actions for the cell selected. 

Here is a quick summary of the available actions, with 
the shortcut keys noted where appropriate: 

Notice that the cell options available change slightly 
according to what you have selected – not all options 
are available for all cells. 

EDIT CELL (ENTER) 

This opens the Edit Cell window for the selected cell. 

CHANGE PICTURE (P) 

You can change the picture in a cell by selecting change 
picture. 



 

 

29 

CHANGE STYLE (S) 

The style of a cell determines what it looks like, 
including the colours used and the shape of the cell.  
We’ll look at styles in more detail later. 

REALLY USEFUL CELLS 

Selecting really useful cells gives you a selection of 
common cells to choose from when making a grid. 

CREATE A JUMP CELL (J) 

Make a cell that jumps to another grid.  This is very 
useful as it allows you to link grids together.  You can 

also jump to the ‘home’ grid or jump back to the 
previous grid. 

AUTO CONTENT CELL 

Auto content cells are special cells that are filled in 
when The Grid 2 is running, for example prediction cells 
that anticipate what the user might be writing. 

CLEAR THIS CELL (DELETE) 

Remove the picture, text, description, style and any 
commands from the cell. 

INCLUDE IN SCAN / DO NOT SCAN (0 - ZERO) 

You can mark cells to be excluded from a scan so that 
switch users cannot access them.  Cells that have been 
excluded in this way are marked with an X in a red box 
in the corner. 

FOLLOW JUMP (F) 

If you select a jump cell, you get the option to follow 
the jump.  This allows you to edit the grid that this cell 
jumps to. 

5.7. Saving your changes 
Once you are happy with the changes that you have 

made, you can save the grid to commit the changes. To 
do this, click on the Save icon on the toolbar. 
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When you have finished editing, click on the Stop icon 
on the toolbar, or press F11, to leave Edit Mode and see 
how the grid looks.  If you have made changes that are 
not saved, you will be asked if you wish to save the 

changes. 

5.8. Adding or removing cells 
You may decide that the grid you are editing does not 
have the right number of cells – you may want an extra 
row or column. 

ADDING A NEW ROW OR COLUMN 

To insert a row (or column) click on the triangle at the 
end of the row, and select Insert row above/below . 

DELETING A ROW OR COLUMN 

Similarly, to delete a row (or column) you can click on 
the triangle and select Delete row . 

5.9. Jumping 
Almost all users will have more than one grid, and these 
grids are linked by jumps.  When a user selects a jump 
cell, the destination grid is opened. 

There is no hierarchy or ordering of grids in The Grid 2; 
any one of the user’s grids can jump to any other grid. 

To create a jump cell, select a blank cell and press J.  
This will show the “jump to…” dialogue, which allows 
you to select the grid you want to link to. 
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JUMP BACK AND JUMP HOME 

There are two ‘special’ jumps that you can make, jump 
back and jump home.  Unlike other jumps, these do not 
jump to a named grid.  Jump back jumps to the previous 
grid viewed, and jump home goes to the user’s 

designated home grid (this is the first grid displayed 
when the user is loaded). 

Grid Explorer allows you to select which grid is the 

home grid for each user.  The start grid is marked with 
a red box in Grid Explorer. 

JUMP TO A NEW GRID 

You can create a new grid when you are making a jump 
cell.  To do this, click on the New Grid icon in the 
toolbar of the “jump to…” dialogue, and enter the name 
for the new grid. 

SELF CLOSING, POP UP AND BOOKMARKED GRIDS 

There are some cool things you can do to reduce the 
number of times a user has to select a ‘jump back’ cell.  
These are covered in more detail in chapter 6. 
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5.10. Changing how a cell looks 
Often you will want to change the appearance of a cell, 
to help distinguish it from other cells. 

For each cell you can change the text, picture, 
description and style. Style determines the colour, font 
and shape of the cell.  To change these settings for a 
cell, open the Edit Cell window and look at the Cell 
Appearance portion of the window (at the top). 

 

CHANGING THE CELL TEXT 

The cell text is the text that appears in the cell.  You 
can type whatever you want in here. 

Tip: you can use Shift+Enter to split the cell text over 
more than one line. 

CHANGING THE CELL DESCRIPTION 

The cell description is used for auditory feedback 
(providing spoken descriptions of each cell to aid the 
user) and for tooltips (written descriptions that appear 
if the mouse pointer hovers over a cell). 

The cell description is linked to the cell text so that if 

you change one, the other changes too.  If you want to 
change the text or the description independently then 
click on the link to break it. 
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CHANGING THE PICTURE 

Click on the Change Picture button to change the 
picture in the cell.  You can: 

• Find a picture from the picture library.  Type 

different words to try and find the best picture. 

• Capture a picture from the screen.  This could be 
a picture on a web page or from a digital camera. 

• Browse for a picture file saved on your computer. 

• Choose not to have a picture for the cell. 

 

CHANGING THE STYLE 

You can select a preset style from the list of styles, or 
click on the Change Style button for more options.  The 
style of a cell includes: 

• Text font and size 

• Colour of border, background and text 

• Shape of the cell background 

• Picture size 
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PRESET STYLES  

There are many times that you will want to have more 
than one cell looking the same.  In The Grid 2, this is 
best achieved with preset styles. 

There are a few preset styles that are always present 
for every user, such as “jump cell” and “vocab cell”.  In 
addition to this, you can create your own preset styles. 

For example, you may wish to create a preset style 

called “family” that you use for vocab cells with 
“mum”, “dad”, “brother” and “sister” on them. 

Once you have created a preset style, you can use it for 
any cell in any grid for that user. 

The real advantage of preset styles comes in when you 
want to make a change to the style.  By changing the 
preset style (e.g. making the font larger), all cells that 

use the preset style are updated. 

INDIVIDUAL STYLES  

Occasionally, you will have a situation where you have 
just one or two cells that you want to set the style for.  
In this case, you can specify an individual style for the 
cell.  This allows you to set the style for the cell without 

affecting any other cells. 
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5.11. Grid settings 
To access settings that apply to a grid, such as changing 
the background colour and making a grid self closing, 

select Edit Grid Settings from the left hand side of the 
edit window. 

Note: You must be in edit mode to access Grid Settings. 

 

TITLEBAR TEXT 

The titlebar normally displays the name of the grid, but 
you can write any text to be displayed in the titlebar of 
a grid. 

The colours and text font for the titlebar can be 

configured in User Settings.  You can also opt to hide 
the titlebar, so if it is not visible then open user settings 
and choose the option to display the titlebar. 

GRID BACKGROUND 

Grid backgrounds can help users to identify which grid 
they are on.  For example, you could choose to have the 

home page with a blue background and other pages with 
a green background. 
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You can select to have the background as a single (solid) 
colour, a fade between two colours or an image. 

If you select a solid colour or a fade, the colour(s) can 
be selected using the two buttons provided. 

If you use an image you can select to stretch the picture 
or tile the picture.  Stretch picture will resize the image 
to fill the screen, and tile picture will repeat the image 
across the screen. 

SELF CLOSING GRID 

Self closing grids jump back when the user has selected 

a cell from the grid.  To make a grid self close, tick the 
self closing grid box. 

You can read more about self closing grids in chapter 6. 

AUTO CONTENT 

Grids that have prediction auto content cells will 
normally suggest words from the prediction dictionary, 
but you can make a grid that prioritises other words. 

 

This allows you to create a grid that emphasises words 
on a particular topic.  Add the topic words to the Word 
List for the grid, and then select the appropriate option. 
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Show words from full dictionary will use the complete 
dictionary of words that have been learnt from the user. 

Only show words from this grid’s word list will only 
predict words that you have added to the word list, and 

not include any words from the full prediction dictionary. 

Show words from the word list first, then use full 
dictionary will suggest all the available matches from 
the word list.  If there are auto content cells with 
prediction, remaining then these will be populated from 
the full prediction dictionary. 

BLOCK SCANNING 

One of the options that can help switch users to access 
large grids more quickly is block scanning.  This divides 
the grid into blocks of cells to reduce the selection set 
quickly. 

 

The groups of cells that are highlighted together are 
called scan blocks.  Normally, The Grid 2 will 
automatically determine if scan blocks are required and 
where they should lie.  For some grids you may wish to 
specify where the scan blocks lie.  If you select the 
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option I want to select scan blocks manually then you 
can arrange the scan blocks when in edit mode. 

AUDITORY CUES FOR SCANNING ROWS, COLUMNS AND BLOCKS 

When using auditory scanning, the description of each 

cell is spoken when it is highlighted to allow the user to 
identify the cell that they want. 

When scanning a group of cells in a row, column or 
block then the description of the first cell in the group 
is used.  This is not always appropriate, and so you can 
manually determine the auditory scanning description 

for each group. 

For example, you might configure the rows in the grid 
pictured to have the auditory scanning cues “a to d”, “e 
to h”, “i to n”, etc. 

To change the description for a group of cells, select 

the item in the list and click on Change.  If you clear an 
entry then the description of the first cell in the group 
will be used. 

CELL SIZE 

When using the Computer Control workspace, grids are 
displayed in a corner of the screen to allow other 

Windows programs to be seen.  The height of the cells is 
configured in User Settings, and this is the same for all 
grids. 
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The width of the cells can be different for each grid.  
For most grids you will probably want to fill the width of 
the screen, but for some grids you may choose to have a 
smaller grid to allow more of the screen to be seen. 

If you select the Cell height multiplied by option you 
can specify the aspect ratio of the cells. 

COMMANDS 

You can specify commands to be activated every time 
the grid is opened.  This can be used in different ways, 
for example a music player grid might have the “Music 
Player Workspace” command in the grid’s command list. 
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To change the command list, select Edit Grid 
Commands from the Commands tab. 
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6. Smart ways to jump 

6.1. Self closing (pop-up) grids 
A handy feature in The Grid 2 allows you to create a 

grid that will jump back when a cell is selected.  In our 
formal jargon these are called self closing grids, but 
they are often called pop-ups because they perform a 
similar function to pop-up grids in other AAC software. 

The primary motive for creating self closing grids is to 
reduce the number of selections that the user needs to 
make – particularly valuable for users for whom each 

selection is time consuming or difficult. 

Self closing grids are primarily used when there is a 
mutually exclusive set of options – for example you 
might use it for a page with a choice of colours. 

MAKING A GRID SELF CLOSING 

To make a grid self closing, go into edit mode, click on 

grid settings and then tick the box marked self closing 
grid. 

EXEMPTIONS 

Certain cells are exempt from self closing.  These are 
cells that you might select without closing the grid, for 
example, you wouldn’t want a jump cell to self close a 
grid. 

The more auto content command also makes a cell 
exempt from self closing, because you would not want 
to display more words and then immediately close the 
grid. 

STAY ON GRID 

There is a command that you can add to a self closing 

grid to allow the user to stay on the grid if they wish to.  
The Stay on grid command has a ‘pin’ image, and once 
selected the user can make as many selections as they 
wish before jumping to a different grid. 
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6.2. Bookmarks 
Bookmarks are another useful feature when jumping.  
You can store a bookmark at any time by using the 

Bookmark command.  This places a marker on the 
current grid, and next time a cell jumps back you will 
return to that grid. 

This is really useful if there are sub-categories that have 
to be navigated in order to find the word that is wanted. 
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Without bookmarks: 

 
With normal jumps, the user would have to jump back 

through each grid to get to the start.  In the example 
above, the user goes from Home to Food to Snacks and 
selects the word that they want (green arrows).  They 
then need to jump back twice to get back to the start 
(orange arrows). 

 

With bookmarks: 

 
This time, the first grid was bookmarked before 

jumping.  As a result, when the user jumped back from 
the Snacks page, they landed right back at the 
(bookmarked) Home page. 

Home 

Food 

Snacks 

Bookmark 

Home 

Food 

Snacks 
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CREATING A BOOKMARK JUMP 

To place a bookmark when jumping, add the bookmark 
command to the command list of the cell that jumps. 

 

Note that the bookmark command should be before the 

jump command because it bookmarks the current grid.  
If the bookmark command were to appear after the 
jump command then it would bookmark the grid that 
you are jumping to! 

You cannot have more than one bookmark, so if you 
have a bookmark placed and a cell creates a new 
bookmark then the first bookmark is lost. 

BOOKMARKS WITH SELF CLOSING GRIDS  

If you’re feeling clever, you can combine self closing 

grids with bookmarks.  In the above example, if the 
Snacks page were self closing then as soon as the user 
selected their snack, they would be back at the Home 
page. 
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7. Making a keyboard grid 
There are a number of keyboard grids available with 
different layouts, including qwerty, alphabetical, 

frequency-of-use and auditory scanning.  You will often 
be able to use one of the existing grids rather than 
starting from scratch, but it is still useful to know how 
to create cells that act as keyboard keys. 

To create a keyboard key, select a blank cell and open 
the Edit Cell window.  Just below the vocab cell quick 
shortcut is another space to enter a Keyboard key.  

Type the key that you want to be typed in here.  For 
special keys such as Enter, you can drop down the list 
and select them. 

 

Creating a keyboard key in this way is very similar to 
creating a quick vocab cell, but there are a few 

differences: 

• Keyboard keys do not have a picture 

• The ‘keyboard key’ style is selected 

• No space is added to the text command 
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8. Commands 
Each cell in The Grid 2 will perform one or more actions 
when it is selected.  The actions that a cell performs are 

determined by the commands for that cell. 

To see the commands for a cell, open the Edit Cell 
window. 

 

If you have several commands, they can be ‘collapsed’ 

to allow you to get an overview of the commands for a 
cell.  To expand or collapse an individual command, 
click on the double arrows in the top right corner of 
that command. 

ADDING A COMMAND TO A CELL 

If you want a cell to perform a function in The Grid 2, 
you add the corresponding command to the cell.  For 
example, to make a cell speak the sentence, you add a 
speak command. 

To add a command: 

1. Press F11 to enter edit mode. 

2. Double click on the cell you want to edit. 

3. Click on the add command label at the bottom of 
the command list. 
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4. Select the command category from the list on 

the left.  Commands are grouped according to 
how they are used. 

5. Select the command from the list in the middle.  
A description of the command will be shown on 
the right to help you select the correct command. 

6. Click Ok to add the command to the cell. 

REARRANGING THE COMMANDS 

You can select the order in which commands appear.  
Commands are processed from the top of the list to the 
bottom. 

To move a command up or down in the list, click on the 
up or down label at the bottom of the command. 

DELETING A COMMAND 

To remove a command from a cell, click on the delete 
label at the bottom of the command. 

AUTOMATICALLY SELECTED COMMANDS 

When you make a cell using the quick shortcuts (such as 
vocab cells, jump cells or really useful cells) the 
commands are selected for you. 
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8.1. Some commands in detail 
We’ll take a closer look at some of the important 
commands in closer detail. 

THE TEXT COMMAND 

The most often used command is the text command.  
The text command writes into the current workspace, if 
possible.  For text-based workspaces (including text 
chat, text chat + messages, email, SMS and word 
processor) the words appear at the cursor as if they 
were typed with a keyboard. 

For the symbol workspaces (symbol chat and simple 
symbol chat, a picture also appears above the word.  
This is normally the same picture that is displayed in the 
cell, but you can specify a different picture if you wish. 

 

The Text command is added for you when creating a 

vocab cell or a keyboard key.   

Note that when you make a vocab cell, a space is 

automatically added to your text.  If you edit a text 
command manually, you will usually want to ensure 
there is a space to the end of the text. 

You can specify a media file (sound or video) to play 
when the cell is selected, allowing you to use recorded 
speech or videos in sentences. 
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There are some codes that can be inserted in the text 
command to type keys that cannot normally be pressed: 

• {ENTER}  Enter key 

• {BACKSPACE}  Backspace key 

• {SPACE}  Space bar 

A complete list of codes can be found in the appendix at 
the end of this book. 

Your user settings determine whether the text 

command speaks when selected.  You can choose to 
speak each letter, word or sentence typed. 

SPEAK COMMANDS  

 

The Speak command will read aloud from the current 
workspace.  This allows you to construct a sentence and 
then read the complete sentence aloud. 

The Speak now command speaks some text aloud 
without involving the workspace.  This is useful if you 
want to speak a complete message instantly, such as “I 

need the toilet!” 

Speak sentence is used when writing longer text (such 
as an email or in the word processor workspace) and will 
only read the current sentence.  It is also used in the 
text chat + messages workspace to read the selected 
message. 
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Speak word will speak the word at the cursor.  This can 
be used effectively for people with difficulty reading. 

Stop speaking will stop any speech in progress. 

JUMP COMMANDS  

 

The Jump home command jumps to the home grid – this 
is the first grid displayed when the user is opened.  You 
can change the home grid in Grid Explorer. 

Jump back returns to the previous grid visited. 

Grids that are self closing jump back automatically 
when you select a cell on that grid. 

The Jump to command jumps to a named grid. 

The Bookmark grid command stores a bookmark for the 

current grid.  Next time a cell jumps back (or self 
closes) you will be taken back to the bookmarked grid, 
even if it was not the previous grid. 

Note: You should place the bookmark command before 

the jump command to bookmark a grid when jumping to 
a different grid. 

The Stay on self closing grid command allows the user 
to over-ride this behaviour and select more than one 
cell from a self closing grid. 
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8.2. Commands for users and grids 
You can specify commands to be actioned when a user 
or a grid is opened. 

COMMANDS FOR A USER 

To specify commands for a user, select Edit > User 
Settings from the menu, and then select the General 
settings > Startup page.  Click on the button Edit user’s 
startup commands to change the commands. 

 

These commands are activated when the user is loaded.  
One example for using this feature is to say “welcome” 
when the program has loaded, to let the user know that 

it is ready for them to start. 

COMMAND FOR A GRID 

To specify commands for a grid, select Edit Grid 
Settings and then chose the Commands tab.  The 
button Edit grid commands allows you to edit the 
commands for this grid.   
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Grid commands are executed when the user jumps to 
the grid. 

One example for use of this is a music player grid, with 
a command to switch to the music player workspace 
each time the grid is opened. 

Note that the commands for a grid are executed 

immediately after the jump to the grid.  If the cell that 
initiated the jump has further commands on it, these 
will be executed after the grid’s startup commands. 
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9. Auto content 
The Grid 2 uses auto content to allow you to populate 
cells dynamically.  What this means is that the cells are 

selected and arranged automatically.  There are a few 
different types of auto content that can be used on a 
grid. 

 

Word list auto content displays a list of vocabulary. 

Prediction auto content suggests words as you write. 

Contacts auto content displays contacts for sending 
email and SMS messages to. 

Web favourites auto content displays web pages that 
the user has stored as favourites. 

9.1. Creating auto content cells 
To use auto content on a grid, you need to select one or 

more cells and allocate them for auto content.   

Open the grid that you want to edit, and go into edit 
mode.  Click on the cell that you want to use for auto 
content to select it. 

Tip: you can hold control and drag the mouse to select 
a group of cells. 
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Now select Auto content cell from the cell options on 
the left, and choose the type of auto content that you 
wish to use. 

Note: this option is only available for blank cells.  If the 

cell has some other stuff in it, you need to clear it 
first. 

You can also choose Edit cell (or double click on a cell) 
and then select Special cells on the left to create an 

auto content cell. 

9.2. Word lists 
Word lists are used to provide access to a number of 
words on a grid.  Each grid has its own word list, and the 
words from this list are displayed in the auto content 
cells. 

 

WHY WOULD I WANT TO USE A WORD LIST? 

Word lists provide the same effect as creating a grid full 
of vocab cells, but there are a few advantages to using 
word list auto content. 

First of all, the list is automatically arranged.  This 

means that if you come back to the grid later and want 
to put another word in the middle of the grid, you don’t 
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need to shuffle all the other cells along.  You can add, 
remove or change the order of words in the list, and 
they will be arranged on the grid for you. 

The next advantage is that word lists allow you to have 

a long list of vocabulary without having to make 
multiple grids.  If there are more words in the word list 
than there are available auto content cells, you can 
create a ‘more’ button that will show the next bunch of 
words from the word list. 

EDITING THE WORD LIST 

To edit the word list for a grid, select Edit word list.  In 
edit mode, this appears on the left under Grid Options, 
and when you’re not editing you can find it in the menu 
under Auto Content > Word list for this grid. 

Note that the words will not show up in the cells when 

you are in edit mode.  The cells will display “word list 
1”, “word list 2”, etc.  Once you stop editing, the 
words will be displayed in the cells. 

 

The box on the left displays words that are currently in 
the word list.  Select Add a New Word (or hit enter) 

and type a word to add it to the list.  You can also enter 
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a longer phrase or sentence if you wish.  The picture 
will be located automatically and you can select a 
different picture if you want. 

If you select a word in the list, you can change some 

options for the word.  Edit the spelling of the word in 
the box provided, or click the buttons to change the 
picture or move it up or down in the list.  You can also 
remove a word from the list here. 

SAVING A WORD LIST 

Sometimes you may wish to save a word list to use on 

anther grid, or send to a friend.  To do this, select File 
> Export Word List from the menu.  The word list and 
any pictures you have selected will be saved in a single 
file. 

If you want to load a word list from a saved file, select 
File > Import Word List. 

You can also load words from a text file by selecting 

File > Add Words From Text File.  This takes each line 
of the file and makes it a separate entry in the word list. 

Note: you can load word banks from The Grid 1 by using 
Add Words From Text File. 

WORD LIST TOOLS  

The Tools menu provides a few handy tools to make it 
easier to manage a word list.  Sort alphabetically will 
put the words in order for you, whilst Find Pictures will 
look for a picture for all words that do not have a 
picture. 

When the words are selected and written into the 

workspace, they should have a space after them 
(otherwise the next word selected will be merged with 
it).  Add space after words ensures that every word has 
a space at the end. 

To keep the word list tidy, you can Remove duplicate 
words. Remove words without a picture can be quite 
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handy if you have imported a word list for a user who 
needs symbol support. 

Finally Clear word list provides a quick way to remove 
all the words and start again. 

9.3. Prediction 
Prediction offers suggestions for words as you type.  For 
example, if you type “hel” the prediction might suggest 
“hello” or “helicopter”. 

LEARNING FROM YOU 

The words suggested by prediction change as you use 

The Grid 2 because it learns which words you use and 
how often you use them. 

NEXT WORD PREDICTION 

After you type a word, the prediction system will try to 
guess which word you will write next.  This is based 
upon previous typing, so you will find that the more you 
write, the more the suggestions suit your writing style. 

PREDICTION SETTINGS 

You can turn on or off some features related to 
prediction in the user settings.  Select Edit > User 
settings from the menu, then locate the Dictionaries > 
Prediction page. 

You can set a minimum length for suggestions, for 

users who can quickly and confidently type short words. 

You can also choose to show pictures in prediction 
cells, which will select the best picture from your 
selected symbol library to accompany each word.  For 
users who rely on symbols, you can eliminate words that 
do not have a picture. 

If a user’s access is slow and they are reading every 

word that is offered in prediction cells, you could select 
remove words already suggested from prediction.  If a 
word is suggested but you do not select it, it will not be 
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listed after typing another letter even if it still matches.  
For example, if you type “t” and “the” is suggested, and 
you then type “th” then “the” would not be suggested 
to leave room for other words starting with “th”. 

The option to learn new words and word usage is 
normally switched on.  If you turn it off then The Grid 2 
will not learn which words you use or how often you use 
them, so it will not be able to improve prediction in 
response to the way you write. 

Spell check words before learning is a useful way to 

prevent nonsense from going into the prediction 
dictionary.  Each time you type a word, it is 
remembered so it can be suggested in future.  Typos 
and misspellings would be included if the spell checker 
was switched off. 

ADDING OR REMOVING WORDS FROM PREDICTION 

If the prediction suggests a word that you don’t like, or 

a word that you think should be suggested is missing, 
you can improve the prediction in response to this.  
Select Auto content > Prediction from the menu.  You 
can then enter words to be suggested or removed as 
required.  Each word should be separated by a space or 
a new line (enter key). 

PREDICTING FROM A WORD LIST 

You can seed the prediction for a particular grid to use 
words from a word list.  Press F11 to enter Edit Mode, 
and then select Edit grid settings.  Now select the Auto 
content tab and you can select the source of the 
prediction: 

• Show words from full dictionary: this is normal 

prediction using the full dictionary of words that 
is updated as you write. 

• Only show words from this grid’s word list: the 
prediction dictionary is not used, but words from 
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the grid’s word list are suggested if they match 
the typing of the word so far. 

• Show words from the word list, and then use 

the full dictionary: any matches from the word 
list are identified and displayed, and then if there 
are prediction cells remaining these will be 
populated from the full dictionary. 

SOUNDS-LIKE AND SPELLED-LIKE PREDICTION 

You can use prediction cells to offer spelling suggestions 
to users after they have typed a word.  There are two 

different ways to do this: 

• Sounds-like will suggest words with similar 
phonetics to the word that has been typed. 

• Spelled-like will suggest words with similar 
spelling to the word that has been typed. 

To use these types of prediction, you need to select the 

Sounds-like or Spelled-like commands.  See section 8 for 
information on adding a command to a cell. 

PREDICT THIS 

You can also make a cell that will put the words that 
you want into prediction cells.  For example, you might 
have a button for labelled ‘people’ that would suggest 

“I, me, you, he, she, …”. 

There are two versions of the command for predict this.  
The simple version simply has 10 slots for words and a 
simple yes/no option for finding pictures to go with the 
words. 

The word list version allows you to create a word list 
that is then put into the prediction cells.  It’s a bit more 

complex, but the payoff is that you get to select your 
picture for each word plus you can have more than 10 
words and rearrange the list with ease. 
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VERB MORPHOLOGY  

Verb morphology uses The Grid 2’s built in verb 
database to change the form of a verb.   

Note that you can use verb morphology without 

prediction with the regular Verb Morphology 
command. 

The Verb morphology in prediction command lists 7 
forms of a verb. 

 

You can change the pictures that are displayed in User 
settings, in the Dictionaries > Verb morphology page.  

You can also tick an option to prevent the same form of 
a verb appearing twice (for most regular verbs there is a 
lot of repetition between the different forms of a verb). 

9.4. Contacts 
Contacts will display the people in the user’s contacts 
list in auto content cells.  These people can be selected 

to receive an email or SMS using The Grid 2’s built in 
email and SMS workspaces. 
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EDITING CONTACTS 

You can edit the list of contacts by selecting Auto 
content > Contacts from the menu. 

You can also enable user-editing of contacts via the 

Contacts workspace.  There are some commands 
associated with this workspace that allow the user to 
add, remove or edit their contacts. 

9.5. Web favourites 
The Web favourites auto cells allow the user to store 
web pages that they like so they can go back to them 

easily later. 

EDITING FAVOURITES 

You can edit the list of favourite web pages by selecting 
Auto content > Favourites from the menu. 

There is a command for adding the current web page to 
the list of favourites. 
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10. Computer control grids 
The computer control workspace is different to the 
other workspaces because when it is active your grids 

are not displayed full screen. 

The grids are reduced in size to allow other Windows 
programs to be seen.  When you select a cell with a 
Text command, the text is typed into other windows 
programs. 

10.1. On screen keyboards 
You can create on screen keyboards for typing into 

other Windows programs very easily.  It is easy to 
rearrange the keyboard, and extra cells can be added 
with extra functions. 

MORE THAN JUST A KEYBOARD 

On screen keyboards can be used for more than 
replicating a physical keyboard on the computer screen.  

Cells can be used for mouse control, switch between 
programs and other tasks. 

You can also create ‘macro’ cells – cells that use several 
commands to perform a number of tasks. 

MOUSE CONTROL 

There are a number of commands to enable switch users 
to control the mouse.  You can move the mouse pointer, 

click the buttons and also drag things around.  One 
popular command is the radar mouse for moving the 
mouse pointer around. 

ALTERNATIVES TO MOUSE CONTROL 

Whilst it is possible to move the mouse pointer and click 
the buttons using commands, this is rarely the most 

efficient way to use switches.  Most functions in 
Windows programs have keyboard shortcuts.  For 
example, to create a new document in most programs 
you use the shortcut Control-N or access the menu with 
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Alt-F-N.  These can be done using a single cell in The 
Grid 2, saving a lot of time.  To do this, simple use a 
text command to type the appropriate keys. 

 

To make it easier to use, you can also Change picture 
and Capture the icon from the toolbar of the program 
the grid controls. 
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11. User settings 
Each user’s settings can be carefully configured to suit 
individual needs. 

To open the user settings from the Grid Player, select 
Edit > User Settings from the menu. 

To open the user settings from Grid Explorer, select a 
user and then choose User Settings. 

The user settings are divided into sections. 

11.1. General settings 

ABOUT ME 

 

You can browse for a different picture to display in Grid 

Explorer (such as a photograph of a user) to make it 
easier to differentiate users. 

The Editing lock is used to prevent access the Edit Mode 
from the F11 key or the menu.  This can be useful if 
there are users who have a tendency to meddle with the 
computer! 
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STARTUP 

 

The grid displayed at the start is not only the first grid 
seen when this user is loaded, but also the destination 
for all cells that jump home. 

You can also specify which workspace should be active 

when the user is loaded.  Often this will be a 
communication workspace (i.e. Symbol Chat or Text 
Chat).  This is also the workspace that is selected when 
a cell has the “Change to default workspace” command. 

PRINTING 

 

This page allows you to set up the printer for when the 
user selects a Print cell on one of their grids.  You can 
select which printer to use, what paper size to print to 

and also the paper orientation. 
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Note that this is completely separate to printing grids 

from Grid Explorer.  There are separate printer settings 
for that which are configured when you select which 
grids to print. 

11.2. Appearance settings 

CELL APPEARANCE 

 

These settings affect the appearance of every grid. 

You can select to have the text above or below the 
picture in a cell.  Some users find it easier to have the 

text below, whilst touch screen users may prefer to 
have the text above so it is still visible when selecting 
cells. 

Hide empty cells will remove cells from the grid that do 
not have any content in them.  This is really useful if 
you want to focus the user’s attention on the important 
cells that do stuff.  On the other hand, when learning 

scanning it can be useful to see every cell so that the 
scanning patterns can be predicted more easily. 

Border width is the thickness of the line around each 
cell. 

Cell spacing can be adjusted to give the cells more 
room to ‘breathe’.  A larger cells spacing also makes it 

easier for touch screen users to make accurate 



 

 

67 

selections, and increases the visibility of the highlight 
around each cell.  However, it also makes the cells 
smaller, reducing the picture size and the space 
available for the text. 

Indicator cells are used to let the user know if the 
certain cells are ‘turned on’.  For example, a shift key 
will change colour to indicate that shift is on, and 
change colour again when it is locked.  You can set 
those colours here. 

Fancy effects make the grids look nicer.  If you are 

having problems with the speed that the program runs 
(particularly if pages with many symbols are slow to 
load) then you can try turning these options off and see 
if it helps. 

TITLEBAR 

 

You can display a titlebar above each grid.  Normally 
this will display the name of the grid, but it can also be 
configured to display other information, such as a 

question or a more detailed title for the grid. 

If you display the titlebar, you can configure the font 
and colours used. 
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WORKSPACE COLOURS 

 

Here you can change the colours that are used for the 
text in the workspaces.   

Sentence text is the text colour and background colour 
for writing, and sets the basic colours for all the 

workspaces. 

Highlighted text colours are used when highlighting 
words in time with the speech.  If you do not wish to 
have text highlighted as it is read, set these colours to 
the same as the sentence text. 

Web page links can be a different colour so that the 

user can clearly see which text is a link on a webpage. 

WORKSPACE FONT 
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You can specify a different font and size for each 
workspace. 

11.3. Input settings 

 

Input settings cover all the options available for input 
with pointers (including mouse, touch screen and 

headpointer) switches, and eye-gaze.  Input settings 
are discussed in more detail in sections 12-14. 

11.4. Speech settings 

SPEECH OUTPUT RULES 

 

When you write into workspaces, they can speak the 
text as you write.  Here you can select when the text 
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should be spoken – after completing a sentence, a word 
or a character. 

You can also select to speak the Symbol Chat workspace 
by clicking in it. 

PUBLIC VOICE 

 

The public voice is used to speak for communication. 

Select the voice from the list.  Many voices allow you to 
vary the speed and pitch, and you can also set the 
volume for speech. 

Read one word at a time is useful if you want to force 
the speech to go slowly.  It also forces voices that do 

not highlight each word to do so.  You can change the 
pause between the words. 

Click on test speech to hear the effect of changes you 
make to the voice. 

PRIVATE VOICE 

The private voice is used to speak for auditory feedback 
to the user (see below for more information on auditory 

feedback). 

The settings are largely the same as for the public voice, 
but you can select to Use right audio channel only.  
This arrangement allows the right audio channel to be 
linked to a headset for the user whilst the left audio 
channel is broadcast publicly. 
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AUDITORY FEEDBACK 

 

You can provide extra information to the user about the 
cells using sound.  This is called Auditory Feedback. 

When highlighting cells The Grid 2 can play a sound, 
which will help the user to identify that the highlight is 

moving.  If you select this option, you can change the 
sound by browsing for a different sound file. 

You can also select speak the description to read the 
cell’s description aloud.  Normally this is the text in the 
cell, but the cell description can be changed for each 
cell.  You can also specify the description for rows, 

columns and blocks when using block scanning.  The 
private voice is used for auditory scanning, and it can 
be configured to speak more quickly and quietly than 
the public voice. 

You can also select play a sound when a cell is 
selected to help reinforce the action of selecting a cell. 
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PRONUNCIATION 

 

Here you can change the way that different words are 
pronounced. 

If you have a word that is not being pronounced 
correctly, enter it in the new word box, and enter a 

phonetic version in the pronunciation box.  Click test to 
check how it sounds, and click add pronunciation when 
you have happy with it. 

Note that different voices pronounce words differently.  

Make sure that you have the correct voice selected in 
Public voice before you change the pronunciations. 

You can remove a pronunciation by selecting it in the 
list and clicking remove pronunciation. 
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11.5. Dictionaries 

PREDICTION 

 

You can change the settings for prediction here – see 
section 9.3 for more information on prediction and 
prediction settings. 

SPELLING 

 

The spell checking is used for prediction and for the 
“spelled-like” command.  Type a word to check the 
spelling – you will see a tick or a cross to let you know if 
the spelling is ok. 

If you want to add a word to the dictionary, type the 
word and click Add word.  To remove a word, type it 

and click Remove word. 
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CAPITALISATION 

 

Here you can specify a list of words that are 
automatically capitalised as you write. 

To add a word, simply click add word and then type the 
word.  To remove a word, select it in the list and click 

remove word. 

AUTO REPLACE 

 

This is a place where you can put in command mistakes 
to be replaced automatically.  We’ve put in lots of 
plurals, so for example “foxs” is replaced with “foxes”. 
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ABBREVIATION EXPANSION 

 

Abbreviation expansion allows you to have abbreviations 
for words or phrases that you use often.  When you type 
the abbreviation, the replacement phrase will be 
suggested in the prediction cells. 

VERB MORPHOLOGY  

Change the pictures use for the ‘Verb morphology in 
prediction’ command here, and also select if repeated 
verb forms should be displayed.  See section 9.3 for 
more information on using Verb Morphology. 

PRONUNCIATION 

This is the same as the settings page under Speech 
settings. 

PICTURE SEARCH 

Here you can select which picture library is used to 
search for pictures in prediction cells and when creating 
new cells. 
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11.6. Workspace settings 

 

WORKSPACE COLOURS & WORKSPACE FONT 

These pages are the same as those under Appearance 
settings. 

WORKSPACE PAGES 

Some workspaces have particular settings – for example, 
the email workspace allows you to enter the details so 
that The Grid 2 can access your email account. 
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12. Pointer input 
Pointer input covers a range of different ways of 
accessing a computer.  Anything that moves the 

Windows mouse pointer can be used for pointer input to 
The Grid 2.  This includes: 

• A mouse. 

• A trackball. 

• A touch screen, including those found on a tablet 
PC or a communication aid. 

• A head pointer, such as the SmartNAV. 

Note that the MyTobii eyegaze system has a special 

setup in The Grid 2 and is not counted as pointer input.  
Other eyegaze systems will act as pointer input. 

To find the pointer input settings, select Edit > User 
settings from the menu, and then select Input settings 
> Pointer from the categories available. 

Ensure that Enable mouse input is ticked, and then 
click on the Settings page. 

You can select the type of pointer that you are 

configuring: mouse, touchscreen or headpointer.  When 
you select one of these the relevant options are 
displayed and other options are hidden. 

12.1. Mouse 
There are very few options for mouse input, as it very 
straight forward. 

MAGNIFY HIGHLIGHTED CELL 

This will increase the size of the cell under the mouse 
pointer. 

COLOUR BORDER 

Normally the background of a cell changes colour when 
it is highlighted.  If this option is ticked then the border 
of the cell is highlighted instead. 
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HIGHLIGHT COLOUR 

You can change the colour of the cell that is highlighted. 

12.2. Touchscreen 
Touchscreens have a few more options because they can 
be used in different ways. 

SELECTION METHOD 

There are 3 options here: 

• Touch cell to accept: simply touch the screen to 
make a selection. 

• Accept on timeout: after touching the screen, a 

cell will be highlighted.  This cell will be selected 
unless the screen is touched again within the 
time limit. 

• Hold finger on cell to accept: when you hold 
your finger on one cell for longer than the 

specified time it will be selected.  If you lift your 
finger before the time has elapsed, or move your 
finger onto another cell, then the selection will 
be cancelled. 

There is also a tick box for Accept first cell touched.  
When this is ticked, the highlight stays on the first cell 
that is touched, even if you drag your finger around the 

screen.  If it is not ticked, then the highlight will follow 
your finger and the cell under your finger will be 
selected when you lift your finger. 

MAGNIFY HIGHLIGHTED CELL 

This will increase the size of the cell under the mouse 
pointer. 

COLOUR BORDER 

Normally the background of a cell changes colour when 
it is highlighted.  If this option is ticked then the border 
of the cell is highlighted instead. 
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HIGHLIGHT COLOUR 

You can change the colour of the cell that is highlighted. 

MINIMUM TIME BETWEEN SELECTIONS 

You can avoid accidental repeats by users who have a 

tendency to touch the screen more than once 
involuntarily.  Select the time that the user must wait 
between deliberate selections. 

SELECTION TIME 

This is the time to wait for a selection when using 
Accept on timeout or Hold finger to accept. 

You can also choose to Display countdown indicator, 
which will provide visual feedback when you are 
selecting a cell.  The Countdown indicator colour 
should contrast with the Highlight colour so that you 
can see the countdown clearly. 

12.3. Headpointer 
Headpointers move the mouse pointer around as you 

move your head, so the cell that your head points 
towards will be highlighted. 

SELECTION METHOD 

There are 2 options here: 

• Use mouse click to accept: click the mouse 
button to accept.  Many headpointers allow an 

external switch to be connected to trigger the 
mouse button. 

• Accept on dwell: keep the highlight over a cell 
and the cell will be selected unless the screen is 
touched again within the time limit. 

MAGNIFY HIGHLIGHTED CELL 

This will increase the size of the cell under the mouse 
pointer. 
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COLOUR BORDER 

Normally the background of a cell changes colour when 
it is highlighted.  If this option is ticked then the border 
of the cell is highlighted instead. 

HIGHLIGHT COLOUR 

You can change the colour of the cell that is highlighted. 

SELECTION TIME 

This is the time to wait for a selection when using 
Accept on timeout or Hold finger to accept. 

You can also choose to Display countdown indicator, 

which will provide visual feedback when you are 
selecting a cell.  The Countdown indicator colour 
should contrast with the Highlight colour so that you 
can see the countdown clearly. 

REPEAT SELECTION WITHOUT MOVING THE MOUSE 

When you dwell on a cell to make a selection, you 
normally have to move the highlight away from that cell 

and then back on again to reselect it.  This option 
allows you to repeatedly select the same cell without 
moving your head. 

DWELL CLICK ON OTHER WINDOWS PROGRAMS 

When using the Computer Control workspace, the head 
pointer can dwell click on other applications.  If this 
option is used then the Allowed jitter is the area that 

the mouse pointer can move. 

When this option is used, you will see a target appearing 
around the mouse pointer when it is not over The Grid 2. 
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For the first few moments you will be able to move the 
pointer to fine-tune the location of the target.  The 
target will then lock on, and if the cursor remains within 
the circle for the Selection time then the mouse will 

click at the centre of the target.  If the target locks in 
the wrong location then move the pointer outside the 
target to reset the position. 

12.4. All options 
If you select All options pointer type then all the 
different settings for pointer input are displayed, giving 

you complete control of your pointer input. 
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13. Using switches with The Grid 2 
Switches are used by many people who have restricted 
or unreliable movement.  Switches come in a wide 

variety of shapes and sizes and can be used with almost 
any reliable movement – hands, feet and head are 
common control points, but switches are also available 
that use blinking or sucking to trigger input. 

The selection of switches and switch locations is beyond 
the remit of this document, so we’ll move on to 
consider how switches are used and how to set them up. 

HOW SWITCHES ALLOW YOU TO TAKE CONTROL 

Whilst there are a veritable multitude of options for 
switch input in The Grid 2, the basics of switch input 
come down to a simple mechanism whereby the user 
highlights each cell in turn, and then they press the 
switch to activate the cell being highlighted.  This is 
called the scan pattern.  We’ll look at the options for 

this in a moment, but first we have the tedious but 
essential task of connecting the switches to the 
computer. 

13.1. Connection 
There are many (too many?) different ways for 
connecting switches to a computer, but we can’t do 

much about this.  What we have tried to do is to keep 
things simple within The Grid 2.  Follow these steps: 

1. Plug your switch(es) into your switch adaptor.  
Plug the primary switch (the one that the user 
can use most reliably) into socket 1, and any 
further switches into 2, 3, 4 and so on. 

2. Plug your switch adaptor into the computer (it 
may be built in to a communication aid, in which 
case you don’t need to worry about this step). 

3. Select the type of switch adaptor that you have 
connected. 
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4. Depending upon what sort of switch adaptor you 
are using, you may need to select a port for your 
switch adaptor.  If you’re not sure which port to 
use, start a 1 and test them in turn! 

5. Press your switch and watch the test lights at the 
bottom to ensure that your switch presses are 
detected. 

There are a number of other options on the switch 

connection page for filtering switch presses and long 
hold.  Untick all of these if you’re just starting out: 
we’ll be looking at these options in section 14. 

MY SWITCHES AREN’T DETECTED 

If the lights aren’t coming on then check this quick 
‘idiot’ troubleshooting list – it covers the most common 
problems encountered. 

1. Are you sure the switch works?  Do you have 
another switch you can plug in, or perhaps 
another switch activated device you can test it 
with? 

2. Is the switch plugged in to the switch adaptor? 

3. Is the switch adaptor plugged in to the 

computer? 

4. If it is a battery operated switch adaptor (such 
as radio switches), are the batteries flat? 

5. Have you got the right adaptor selected in The 
Grid 2? 

6. Have you got the right switch port selected? 

MY SWITCH ADAPTOR ISN’T LISTED 

If your particular make and model of switch adaptor 
isn’t listed, try looking for a similar one in the list.  For 
example, if it connects via USB, try one of the other USB 
connectors listed. 
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The Grid 2 doesn’t support all types of switch adaptor, 

notably keyboard or mouse emulators (such as the old 
Don Johnson switch boxes).  This isn’t just down to 
laziness or fussiness on our part: there are serious 
problems when you try to do computer control with 
these switch adaptors.  For example, Windows gets its 

knickers in a twist if you press a switch which acts as a 
mouse button, and in response The Grid tries to click 
the mouse button! 

If you have one of these, we strongly recommend 
getting a USB adaptor that emulates a joystick – these 
sidestep all the confusion and work beautifully. 

THE KEYBOARD SWITCH ADAPTOR DOESN’T WORK WITH COMPUTER 

CONTROL 

Well spotted.  Actually, the keyboard option is only 

there so that people can demonstrate the principles of 
scanning when they forget to take any switches to meet 
someone.  For ‘real world’ usage, keyboard type switch 
input is not recommended (see rant above for details). 

13.2. Scan pattern 

 

When you are configuring the scan pattern, you can test 
out the settings that you have selected by pressing your 

switches: the test region in the bottom left will scan 
using your currently selected settings. 
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For each option, there is a recommended setting – if 
you’re not sure, select this initially and try it out, then 
change to other settings to see what happens. 

SWITCH SELECTION METHOD 

The first key choice to be made when configuring switch 
input is how will the highlight move forwards?  There 
are four options here: 

• Automatic scan: the highlight moves forward on 
a timer, for example highlighting each cell for 1 
second before moving on.  The highlighted cell is 

selected by pressing a switch. 

• Hold to advance: the highlight moves forwards 
on a timer when a switch is held down.  When 
the switch is released, the highlight does not 
move.  The highlighted cell is selected by either 
pressing a second switch, or waiting for a timeout 

(not pressing a switch for a short time). 

• Tap to advance: the highlight moves forward 
each time the user presses a switch.  The 
highlighted cell is selected with a second switch, 
or a timeout (waiting for a while without pressing 
a switch). 

• Elimination: this one is a bit different.  Two (or 
four) highlights are offered to the user and they 
have a switch corresponding to each highlight. 

Recommended setting: Auto scan 

You may also notice the ‘swap scan’ option is available 

for some switch selection methods.  More information 
about this and other extra options can be found in 
section 14. 

CELL SCANNING ORDER 

Selecting cells one at a time is quite laborious.  If you’re 
using a grid with more than five or six cells, it can take 

quite a long time to get to the cells at the bottom of 
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the grid.  Fortunately there is a simple way to improve 
this: cells are grouped, and each group of cells is 
highlighted in turn.  Once a group has been selected, 
individual cells within that group are highlighted. 

The most easily understood (and commonly used) 
example of this is a row column scan.  Each row is 
highlighted in turn, and once selected the highlight 
advances along the individual cells in that row. 

Other options available are worth considering too. 

• Simple scan: each cell is highlighted in turn (no 

groups are used). 

• Row column: each row is highlighted in turn, and 
then individual cells within the selected row are 
highlighted. 

• Column row: each column is highlighted in turn, 
and then individual cells within the selected 

column are highlighted. 

• Overscan: there’s always one that is a bit 
different.  Overscan is the black sheep here: 
we’ll skip over it for now but you can find out 
about it in section 14. 

Recommended setting: Row column scan 

BLOCK SCANNING 

If you tick the block scanning option then each grid is 
divided into a number of groups (usually 4) which are 
highlighted in turn.  Once one of these has been 
selected, the scan process continues within that group 
of cells.  This sounds a bit complicated, but it makes 
great sense in practise, particularly on grids with many 

cells.  There’s more information later about optimising 
this option for particular grid layouts. 

Recommended setting: Block scanning off (unticked) 
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CANCELLING A SCAN 

One of the pitfalls of the group scanning patterns is that 
the user might select the wrong group and need to 
cancel the scan and start again.  There are four ways 

out if this happens: 

• Select the wrong cell: clearly not a good option. 

• Have a secondary switch for cancelling: this is 
nice.  If the user has the ability to use another 
switch (even if it isn’t as easy to use as the 
primary one) then they can hit this to cancel 

wrong selections.  You can also use a ‘long hold’ 
to provide a second switch.  We’ll look at all the 
options for extra switches just a bit later. 

• Offer cancel during scan: once the highlight has 
finished scanning each cell within the group, an 
extra option is offered.  A large X is displayed in 

the centre of the grid and pressing the switch at 
this time will cancel the scan. 

• Maximum number of scans: you can also set a 
maximum number of repetitions that the scan 
will perform.  After the highlight has been over 
all the cells this many times without the user 

making a selection, the scan will be cancelled. 

Recommended setting: Offer cancel off (unticked) 

Recommended setting: Maximum scans unlimited 

13.3. Switch actions 
The switch actions allow you to specify what each 
switch does.  Your first switch is always the primary 

switch, so if you only have one switch, there is nothing 
to select here. 

If you have more than one switch then you can select: 

• Accept: select the highlighted cell. 

• Cancel: abort the scan and start again. 
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• Reverse: go backwards – I missed by stop! 

• Execute commands: make your switch do 
anything (well, almost).  This one is complicated 

(but really cool) so we’ll leave it until the next 
chapter. 

Recommended setting: If you are using the auto scan 
switch selection method then make switch 2 cancel, or 
if you are using tap to advance make switch 2 accept.  
All others should be none initially. 

SELECT ON TIMEOUT 

If you are using Tap to advance or Hold to advance, 
you can select the highlighted cell simply by leaving it 
highlighted for a moment or two.  Tick Select on 
timeout, and find out how to specify the length of time 
in the next section. 

There are a few other options on the switch actions 

page, but leave them unticked for now. 

13.4. Switch timing 
This is where you set up the speed of the scan.  
Everyone is different and most people find it best to 
start slowly and get faster as they practise.  If you 
aren’t too sure what you are doing, start with these 

settings and then adjust them as required (note that 
some timings may be greyed-out to indicate that they 
are not relevant to your setup options). 

• Time when scanning forwards: 3 seconds 

• Extra time for first scan: 2 seconds 

• Time when scanning backwards: 5 seconds 

• Timeout when no switch pressed: 8 seconds 

YOUR SWITCHES ARE READY 

Well, we made it!  We covered a lot of options there but 
hopefully you followed it and can select cells with your 
switches.  Once you’ve used the switches for a while, 
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you may want to see what you can do to make scanning 
more efficient and less frustrating.  The more advanced 
switch options are covered in the next chapter. 
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14. Optimising switch setup 
Once you have a basic switch setup in place, you can 
use several extra options to make switching faster and 

less frustrating. 

14.1. Switch connection 

FILTERING ACCIDENTAL PRESSES  

You can filter out unwanted presses caused by 
involuntary movement such as a tremor.  Low quality 
switches or switch cables can also cause switches to 
activate several times when they are pressed or 

released, and this can be filtered out. 

Filter short presses will ignore any switch presses 
shorter than the selected time. 

Filter repeat switch presses will ignore any switch 
presses within (say) 1 second of the previous switch 
presses.  The time can be selected. 

To test the switch filtering, press the switch(es) and 
watch the test lights in the bottom left of the window.  
This will tell you if the switch press has been accepted, 
or if it has been filtered out. 

LONG HOLD FOR EXTRA CONTROL 

It is often really useful to have a second switch that will 
cancel the scan, so that incorrect selections do not take 

too long to recover from.  For many people a second 
switch is not viable, but a long hold is an alternate 
option. 

When this option is turned on, holding a switch for 
longer than a specified time will cause a different 
switch action to a normal switch press.  You can test the 

long hold time using the test lights in the corner of the 
window.  In Switch actions you can select the action 
that will happen when a long hold takes place. 
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14.2. Scan pattern 
Optimising the scan is a very effective way to enhance 
the speed of access, mainly because you can reduce the 

number of options that are scanned or selected. 

SWAP SCAN  

Swap scan is only available when using 2 switches with 
either Hold to advance or Tap to advance. 

Normally the primary switch is used to advance the scan, 
but with swap scan, the secondary switch is also used to 
advance the scan.  This is best demonstrated with an 

example: 

If swap scan is not selected then a row column scan 
would advance like this: 

Switch 1 Advance through the rows 
Switch 2 Select the highlighted row 
Switch 1 Advance through the cells 
Switch 2 Select the highlighted cell 

With swap scan, the number of switch selections 
required is reduced: 

Switch 1 Advance through the rows 
Switch 2 Select the highlighted row  
  and advance through the cells 
Switch 1 Select the highlighted cell 

OVERSCAN 

Overscan is a technique in which the highlight runs 
quickly over the cells, at a rate that is too fast for the 
user to select accurately.  When the user presses the 
switch, they will overshoot the cell so the scan then 
runs slowly backwards to locate the cell that was 
wanted. 

To try out overscan (it is worth a try!) set these switch 
times: 

• Time when scanning forwards: 0.2 seconds 
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• Extra time for first scan: 1 seconds 

• Time when scanning backwards: 3 seconds 

BLOCK SCANNING 

Block scanning is a very useful option for locating the 
correct part of a large grid quickly.  Scanning to the 
bottom-right corner of a large grid using row column 
scanning takes quite a while, and block scanning can 
help speed this up. 

When it is turned on, The Grid 2 divides large grids 
horizontally and vertically.  The highlight then starts by 

scanning between the blocks of cells.  Once a block of 
cells has been selected, the scan continues as normal 
within that group of cells. 

You can override the normal pattern of scan blocks for 
each grid and select which cells are in each block. 

To do this: 

• Press F11 to enter Edit Mode 

• Click on Edit grid settings 

• Click on the Scanning tab 

• Select I want to select scan blocks manually 

• Click on Ok 

This grid will now be ready to have the scan blocks 
manually allocated. 

Select View > Cell information > Scan block from the 
menu.  The corner of each cell will have a number to 
indicate which scan block that cell is in.  To change the 
block that a cell is in, select the cell and press a number 

from 1-8.  You can also press 0 to mark a cell that 
should not be scanned, indicated with an X in a red box. 

To include a cell in more than one scan block, double-
click on the cell.  Expand the Scanning options in the 
bar on the left and select Change scan block.  Here you 
can tick more than one block to include the scan in. 
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ELIMINATION 

Selection by elimination is a new way to select cells in 
The Grid 2.  The principle is that you have 2 switches, 
and the cells are split into 2 groups.  You press the 

switch corresponding to the group of cells you want, and 
this group is sub-divided into 2 smaller groups of cells.  
This is a very efficient way to select cells. 

For ease-of-use, your switches should be different 
colours (you can set the highlight colours to match the 
switches). 

If you’re feeling dextrous and adventurous, you can also 
eliminate with 4 switches. 

14.3. Switch actions 

EXECUTE COMMANDS 

In addition to some predictable switch actions (accept, 
cancel and reverse) there is another option: Execute 
command(s).  This allows you to activate any Grid 2 

command by pressing a switch. 

For most users, this won’t be one of their primary 
switches, but it could be used on a secondary switch (or 
a long hold).  Useful ways to use this switch action 
include: 

• Activate an environment control function, such as 

an alarm 

• A switch could be configured to speak “yes” on a 
short press or “no” on a long hold 

REPEAT SELECTION WITH SWITCH 2 

With most scanning setups, only switch 1 can be used 
when not scanning; other switches have no effect until 

the scan is started.  You can take advantage of this by 
using switch 2 to repeat the last cell selected when 
pressed.  Furthermore, if the last cell was a jump then 
switch 2 will jump back. 
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START NEXT SCAN AUTOMATICALLY  

If you are using an Auto scan that advances on a timer, 
you can opt to start the next scan as soon as a cell is 
selected.  This reduces the number of switch presses 

required. 

If you use this option, you probably should consider 
setting Maximum scans to 2 or fewer (Maximum scans is 
an option on the Scan pattern page). 
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15. Grid explorer 
Grid Explorer is used for managing users and grids. 

15.1. Exploring users 
Most of the options for users are accessed by selecting a 
user and either looking in the menu, at the bar on the 
left, or by right-clicking on a user to show a context 
menu. 

 

NEW USER 

To create a new user, click the New User button on the 
toolbar or in the bar on the left.  Enter a name for the 

new user (you can change the name later). 

ACTIVATE USER 

Activating a will load the user’s settings and grids.  This 
is the default action, so you can double click on a user 
or press enter to activate the selected user. 

EXPLORE USER 

This opens a new Grid Explorer window showing the 

grids that this user has. 

SET START USER 

This will make this user the default user for when The 
Grid 2 starts.  The default user has a red border.  To set 
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The Grid 2 to start with the default user instead of Grid 
Explorer, see section 16 of this guide. 

CLONE USER 

Clone user will make a copy of the current user.  All the 

settings and grids will be duplicated and the two users 
can then be modified independently of each other. 

RENAME USER 

Change the name of a user.  You can also press F2 to 
rename the selected user. 

DELETE USER 

Remove all of a user’s grids and settings from your 
computer.  Note: this cannot be undone, so use with 
caution! 

USER SETTINGS 

Edit the settings for the selected user. 

15.2. Exploring grids 
To explore a user’s grids, select a user and then choose 

Explore User. 

 

OPEN GRID 

Open the selected grid.  If the user who owns this grid is 
not loaded, that user will be loaded. 
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Only one grid can be loaded at a time, so if you have 
another grid open it will be closed. 

MAKE HOME 

Set the selected grid as the Home grid.  This is the first 

grid displayed when this user is activated. 

DUPLICATE GRID 

Make a copy of a grid. 

RENAME GRID 

Change the name of a grid. 

DELETE GRID 

Remove the selected grid from the computer.  Note: use 
with care; this cannot be undone. 

PRINT GRID 

Print grids for your records or for use as a 
communication book. 

USER SETTINGS 

Change the settings for the selected user. 

15.3. Grid Explorer Tools 

IMPORT/EXPORT GRID BUNDLE 

A grid bundle is a group of one of more grids that are 
compressed into a single file for easy sharing.  Grid 
bundles can be sent by email or uploaded to the Online 
Grid website. 

Select some grids and click Export grid bundle to save 
them as a grid bundle.  To import a grid bundle, double 
click on the saved grid bundle in Windows Explorer, or 
select Import grid bundle and locate the file. 

IMPORT FROM ‘THE GRID 1’ 

To import grids from The Grid 1, select this option and 
then select the user from whom you wish to import grids.  
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Once the grids and settings have been copied across 
from The Grid 1, you should check the user settings as 
there are many options in The Grid 2 that were not 
available in The Grid 1. 

BURN TO A CD 

Computers are much more reliable than they used to be, 
but they do still go wrong sometimes - and accidents do 
happen.  We’d be unhappy if you lost any grids or 
settings that you’d invested time and love in perfecting, 
and so we’ve made it easier for you to back up your Grid 

2 users and grids. 

Burning users to a CD is also a really good way to share 
your users and grids between multiple computers. 

The Grid 2 will prepare the user’s files ready to be 
written to the CD, and then launch the Windows CD 
writing wizard for saving the files to the CD.   

 

Follow the instructions on screen to complete the CD 
writing process. 

RESTORING A BACKUP 

If you want to restore some grids from a CD onto your 
computer, you’ll need to get your hands dirty with 
Windows Explorer.  It’s not tricky, but you’ll need to 
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pay attention if you’re not familiar with copying files in 
Windows. 

1) Close The Grid 2 if it is open.  It will just get in 
the way. 

2) Open My Computer, and double click on the 
folders to locate your Users folder: 

C:\Program Files\Sensory Software\The Grid 2\Users\ 

3) You need to pop the CD with the user(s) into the 
drive.  Windows should attempt to auto-play the 
CD and offer you the option to Explore files on 

the CD.  If not, you’ll need to open My Computer 
again and locate the CD drive. 

4) On the CD you will see one folder for each user 
that has been saved to the CD.  And in your Users 
folder, you will see one folder for each user that 
is on your computer.  If the user that you want to 
get off the CD is not already on your computer, it 

will be straightforward to drag the folder from 
the CD into your user’s folder. 
If a user with that name already exists on your PC, 
you’re going to have to rename or delete the 
folder before copying off the CD.  It is usual to 
rename the user by adding the word “old” to the 
end of the folder name – and make sure that the 

backup is all working and contains the grids you 
expected before deleting the unwanted user. 

FIND GRIDS ONLINE 

This will launch the Online Grids website, where you can 
see grids made by other people and also add your own 
grids for others to use. 

15.4. Changing the view 
You can view grids and users in different ways to make 
it clearer. 
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ICONS / LIST 

Each user or grid is shown with a large icon (icons) or a 
small icon (list). 

THUMBNAILS 

A preview of each grid is displayed in a thumbnail to 
help identify which grid is which. 

DETAILS 

See more information about each user. 

CHART 

The grids are displayed in an organisational chart. 

 

The first grid on the left is the Home grid.  From there, 
arrows extend to the grids that can be reached from the 
home page.  Grids with a shadow have jumps on them; 
click on a grid twice to expand the jumps from that grid. 
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16. Program preferences 
Program preferences allow you to change settings that 
apply to the whole program. 

To access the preferences select File > Preferences 
from the menu. 

16.1. Options 

 

SHOW THE AVAILABLE USERS IN GRID EXPLORER 

Grid Explorer will be displayed when The Grid 2 starts, 

so you can select a user. 

START THE DEFAULT USER IMMEDIATELY  

The Grid 2 will start with the default user instead of 
Grid Explorer. 

SHOW MENU BAR ABOVE GRIDS 

The menu bar will be shown above the grids when The 
Grid 2 starts.  The menu bar can be hidden or displayed 

at any time by pressing F12. 
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CLICK IN GRID CORNERS TO SHOW THE MENU BAR 

If the menu bar is hidden then two red squares will 
appear in the corners of the grid.  Click on the left 
square then the right square to redisplay the menu bar.  

This allows you to get to the menu on touch screen 
systems when there is no keyboard connected. 

PREVENT WINDOWS SCREEN SAVER FROM STARTING 

This option stops the screen saver from starting. 

LAUNCH THE GRID 2 WHEN WINDOWS STARTS 

When you turn on your computer, The Grid 2 will start.  

Combined with the ‘Start default user immediately’ 
option, this allows you to go straight into a user’s grids 
when the computer is turned on. 

SHOW SYSTEM GRIDS IN GRID EXPLORER 

There are two special grids in each user’s grids, ‘_New 
Grid’ and ‘_Really Useful Cells’.  These can be edited if 
they are displayed in Grid Explorer. 

‘_New Grid’ is duplicated each time you make a new 
grid for that user.  You can edit this to be a template 
for the layout of a standard page. 

‘_Really Useful Cells’ contains the cells that are 
displayed when you click on Really Useful Cells whilst 
editing a grid. 
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16.2. File locations 

 

LOCATION FOR USER/RESOURCE FILES  

If you wish to specify a different location for a user or 
for a resource files (such as a network drive), you can 
do so here. 

User files are the user’s settings and grids.  Resource 
files are the data files required by The Grid 2. 

LOCATION FOR PCS PICTURES 

If you have the PCS pictures installed, you need to 
specify the picture location so that The Grid 2 can 
locate individual pictures. 

Click on Find to attempt to locate the pictures 
automatically (The Grid 2 will check a few standard 
install locations).  If this fails, click on Browse and 
locate the PCS folder manually. 



 

 

104 

16.3. Monitor 

 

DISPLAY GRIDS ON MONITOR 

If you have a multiple monitor system, you can select 
which monitor is used to display grids. 

RESTRICT SCREEN SIZE 

Tick this option to force your grids to display at a 
different screen size.  This is really useful if you are 
editing grids that will be displayed on a communication 

aid with a small screen, because you can see the size of 
the cells as they will appear on the device. 

You can select a device from the list to get its screen 
size, or determine the fixed screen size by typing the 
dimensions in manually. 

Note that you cannot display grids that are larger than 
the monitor that you are working on! 
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17. Online grids 
You can use grids that have been created by other 
people by visiting our Online Grids website. 

http://grids.sensorysoftware.com 

17.1. Finding grids 
When you first visit the website, you will see the home 
page.  There are different ways to find grids: 

SEARCH 

You can search for a grid by typing key words.  For 
example, you might type “keyboard” if you are looking 

for grids to use for typing. 

SPOTLIGHTED GRIDS  

Sensory Software will spotlight grids that are 
particularly good to draw your attention to.  These are 
listed on the front page of the website. 

CATEGORIES 

Grids are sorted into different categories.  Select a 
category to see all the grids that have been marked for 
inclusion in that category. 

RECENT GRID BUNDLES 

The most recently submitted bundles are listed on the 
right hand side of the page. 

17.2. Downloading grid bundles 
When you locate a grid bundle that interests you, click 
on the name to go to the page for that bundle. 

Here you will see a description of the bundle, along with 
pictures (if submitted) of the grids. 

There is a link to download the grids, and below this you 
can read comments left by other visitors to the site. 
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DOWNLOADING A BUNDLE 

Click on the link to download a grid bundle. 

Once it has downloaded, you will be asked if you want 
to Open or Save the grid bundle.  Select Open to load it 

into The Grid 2 immediately, or Save to store them on 
your computer.  If you save the grid bundle, you can 
open the grids into The Grid 2 later by double clicking  
on the grid bundle, or selecting Import grid bundle in 
Grid Explorer. 

The Grid 2 will then ask where to save the grids in the 

bundle: 

• Create a new user: a new user will be created 
and the grids will be saved there.  This is a good 
way to check out grids without messing up an 
existing user.  Type a name for the new user. 

• Add to existing user: the grids will be saved in 

with other grids for an existing user.  Select the 
user to add the grids to. 

17.3. Becoming a member 
If you want to leave comments on grids or submit your 
own grids for others to use, you need to join the Online 
Grids site. 

Click on Join icon, and fill in the form with your details. 

LEAVING FEEDBACK 

To comment on a grid bundle that you have downloaded, 
go to the page for that bundle, and click on Add a 
comment.  

17.4. Adding a grid bundle 
If you have made some grids that you want to share, you 

can put them online for others to download and use. 
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SAVING YOUR GRIDS AS A BUNDLE 

• Explore the user that has the grids you want to 
share, and select the grids. 

• Click on Export grid bundle to save the grids as a 
single ‘grid bundle’ file.  Save the file on the 
desktop, or somewhere easy to find. 

You may also wish to save a screen shot so others can 
see the grids before they download them.  Get the grid 
you want on the screen, and then select File > Save 
Picture of Grid from the menu. 

PUTTING YOUR GRIDS ONLINE 

• Go to the Online Grids website. 

• Log in (if you are not a member you need to join). 

• Click on Add a grid bundle and fill in the details 
for your grids. 

• Click on Save to save the title and description. 

• Now Browse to locate the saved grid bundle, and 
optionally the saved screenshot(s). 

• Click Save to store the grid bundle. 

UPDATING YOUR GRIDS 

You can return later to update the description of your 
grid bundle, or to resubmit a new file if you have made 
changes. 
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18. Appendices 

18.1. Text command codes 
The following codes can be used in the text command to 

type special characters in curly brackets (shift+[ or shift 
+]). 

Space bar {SPACE} 

Enter key {ENTER} 

Tab key {TAB} 

Backspace key {BACKSPACE} 

Shift key {SHIFT} 

Control key {CONTROL} 

Alt key {ALT} 

Escape key {ESC} 

Home key {HOME} 

End key {END} 

Insert key {INSERT} 

Delete key {DELETE} or {DEL} 

Break key {BREAK} 

Print Screen Key {PRTSC} 

Caps Lock {CAPSLOCK} 

Num Lock {NUMLOCK} 

Scroll Lock {SCROLLLOCK} 

Arrow keys {UP}, {DOWN}, {LEFT}, 
{RIGHT} 

Page Up, Page Down {PGUP},{PGDN} 

F1 … F12 {F1} … {F12} 

Brackets {(}, {)} 

Curly brackets {{}, {}} 
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You can mix regular typing with special characters just 
by typing them in together.  You can, if you wish, use 
more than one text command if this makes it easier to 
manage entering a large amount of text. 

Example: to type hello and then enter, you would enter 
the following type text: 

 hello{enter} 

 

Sometimes you may want to create a keyboard shortcut 
with more than one shift, alt and control held down.  To 
do this, simply type more than one code before the key. 

Example: to type ctrl+alt+s, you would enter the 

following type text: 

 {control}{alt}s 

 

You can also hold down the shift, control or alt keys 
whilst typing more than one character.  To do this, 
enclose the characters in brackets. 

Example: to hold the alt key and type F then O, you 

would enter the following type text: 

 {alt}(fo) 

 


